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1.  Introduction 
 

Ce document recueille des informations sur certains de nos ancêtres. Il est forcément incomplet. Bien 

sûr, il y avait beaucoup plus dans la vie de ces personnes que ce qui est capturé ici. Véritables 

personnages de chair et de sang, ils ont parcouru la terre, élevé leurs familles, chanté, joué à des jeux, 

raconté des blagues et vécu pleinement. Ils ont construit leurs familles, leurs fermes et leurs vies et, 

comme nous tous, ont vécu d'innombrables jours et nuits de chagrin et de joie. Les informations 

trouvées ici sont un enregistrement de quelques-uns de leurs pas, quelques-unes des marques qu'ils 

ont laissées, à partir desquelles nous pouvons dire qu'ils étaient ici. 

 

Ils ont tous contribué à créer le monde qui est le nôtre aujourd'hui. Le plus grand honneur que nous 

puissions leur faire est simplement de faire de notre mieux, avec ce que nous avons et le monde tel que 

nous le trouvons, pour transmettre à ceux qui viennent ensuite le meilleur avenir possible que nous 

puissions leur laisser à notre tour. 

*** 

Les informations sont aussi précises que possible au moment de la préparation de ce document. Au fil 

du temps, des informations supplémentaires et plus précises peuvent être ajoutées par d'autres aux 

documents trouvés en ligne. Certaines inexactitudes seront toujours présentes, par exemple en ce qui 

concerne les dates de naissance, simplement à cause de la faillibilité humaine. Cela peut être vu, par 

exemple, en comparant les dates de naissance données pour les individus dans le Recensement du 

Canada de 1901 et le Recensement du Canada de 1911, où souvent l'année de naissance diffère d'un 

an ou deux, et parfois même le mois de naissance change. L'orthographe des noms varie également 

souvent, car ils ont souvent été enregistrés par un preneur d'enregistrement au mieux qu'ils l'ont 

entendu d'un locuteur qui n'était peut-être pas capable d'écrire. Dans la mesure du possible, j'ai 

enregistré ces détails du mieux que j'ai pu à partir des sources disponibles et de l'exemple le plus 

probablement correct. J'ai essayé d'adopter l'approche la plus conservatrice, et je n'ai ajouté aucune 

information dont je n'étais pas aussi sûr que possible était exacte. 

 

Les cartes ne montrent qu'une partie de leurs voyages, parfois seulement jusqu'au niveau du comté tel 

qu'enregistré par les recensements. Les sections chronologiques ne sont que partiellement complètes, 

répertoriant les informations disponibles sur FamilySearch.org au moment de sa création, par exemple 

dans de nombreux cas, ils n'incluaient  pas la naissance d'enfants qui n'ont pas encore été saisis dans 

la base de données FamilySearch. De même, les tableaux en éventail dans les sous-sections Ancêtres, 

répertoriant les ancêtres sur six générations, affichent autant d'informations que celles disponibles dans 

FamilySearch au moment de l'impression des tableaux. 

 

Dans la copie électronique, tous les liens en bleu sont cliquables pour vous amener à une autre section 

pertinente de ce document ou à une page Web contenant plus d'informations. 

 

Vous pouvez zoomer sur des images difficiles à lire en utilisant la fonction de zoom de votre application, 

qui sur de nombreux ordinateurs peut être effectuée simplement en maintenant la touche Ctrl enfoncée 

et en utilisant la molette de défilement de la souris. La résolution des images est légèrement plus 

élevée dans les documents Word que dans les PDF. 

 

La dernière section Using This Document fournit des informations sur l'utilisation, la modification et 

l'impression de ce document. 

 

Vous pouvez obtenir une copie électronique de ce document que vous pouvez mettre à jour et modifier 

vous-même à partir de https://williamstewart.com/ancestry/ 

 

Ayer du plaisir en lisant ce document, 

William Mott Stewart 

https://williamstewart.com/ancestry/
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2.  Les Ancêtres Daigle 
 

Cette section comprend l'ascendance de la lignée Daigle, de Joseph Zénon Daigle (1934) incluant trois 

générations, quinze personnes en tout. 

 

 

 

Joseph Zénon Daigle 

(1934) 

| 

Joseph Antoine Daigle 

(1899-1988) 

Marie Laura Alberta Daigle 

(1901-1954) 

____________________|_____________________ 

| 

François Joseph Daigle 

(1868-1943) 

Marie Catherine Arsenault 

(1867-1942) 

___________|__________ 

| 

Joseph François Daigle 

(1877-Décédé) 

Cédulie Huard 

(1872-Décédée) 

___________|__________ 

| 

Louis Daigle 

(1831-1909) 

Luce Daigle 

(1833-1903) 

| 

Pierre Arseneau 

(1817-1904) 

Nathalie Daigle 

(1824-Décédée) 

| 

François Joseph Daigle 

(1838-Décédé) 

Marie Blanche Barriault 

(1843-Décédée) 

| 

Joseph Huard 

(1839-1923) 

Rose-Délima St-

Laurent 

(1848-1919) 
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2.1  Arsenault, Marie Catherine (1867-1942) 
 

 
1 - Marie Catherine Arsenault 

 

Fille de Pierre Arseneau (1817-1904) et Nathalie Daigle (1824-Décédée). 

 

Epouse de François Joseph Daigle (1868-1943). 

 

Mère de Joseph Antoine Daigle (1899-1988). 

 

Né le 10 juin 1967, likely à Saint-Charles-Borromée, Kent County, New Brunswick, Canada. 

 

Décédée le 28 mai 1942, probablement à Saint-Charles-Borromée, Kent County, New Brunswick, 

Canada. 
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Elle est baptisée en 1867. En 1871, elle vit avec ses parents et neuf frères et sœurs, à Richibucto, Kent, 

Nouveau-Brunswick. Sa religion est catholique romaine. Son père est agriculteur. En 1891, elle vit avec 

ses parents et ses cinq frères et sœurs. Elle se marie en 1892, à l'âge de 25 ans. En 1901, elle vit avec 

son mari, ses trois enfants et les parents de son mari, à St Louis, Kent, Nouveau-Brunswick. Son mari 

est agriculteur. En 1911, elle vit avec son mari et ses trois enfants, à St Charles, Kent, Nouveau-

Brunswick. En 1921, elle vit avec son mari, son fils et sa femme, et un neveu. Elle a vécu jusqu'à 74 

ans. 

 

Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LBWF-325 

 

 https://www.wikitree.com/wiki/Arsenault-2095 

 

  

Saint-Louis 
Richibucto 

https://www.familysearch.org/tree/person/details/LBWF-325
https://www.wikitree.com/wiki/Arsenault-2095
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2.1.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LBWF-325 

 

 
  

https://www.familysearch.org/tree/person/timeline/LBWF-325
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2.1.2  Baptême (1867) 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364608/media/39481c7c-

eec9-43ae-9062-b9e34bf9d7c9 

 

 
 

2.1.3  Recensement du Canada (1871) 

 

Voir Pierre Arseneau (1817-1904). 

 

2.1.4  Recensement du Canada (1891) 

 

Voir Pierre Arseneau (1817-1904). 

 

2.1.5  Mariage (1892) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.1.6  Recensement du Canada (1901) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.1.7  Recensement du Canada (1911) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.1.8  Recensement du Canada (1921) 

 

Voir François Joseph Daigle (1868-1943). 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364608/media/39481c7c-eec9-43ae-9062-b9e34bf9d7c9
https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364608/media/39481c7c-eec9-43ae-9062-b9e34bf9d7c9
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2.1.9  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.2  Arseneau, Pierre (1817-1904) 
 

Fils de Charlemagne Arsenault (1789-Décédé) et Rose Daigle (1792-Décédée), pas encore inclus dans 

ce document de généalogie. 

 

Epoux de Nathalie Daigle (1824-Décédée). 

 

Père de Marie Catherine Arsenault (1867-1942). 

 

Né le 1 decembre 1817 à Saint-Charles, Kent Ct, NB. 

 

Décédée le 8 janvier 1904, à Saint-Charles, Kent Ct, NB. 

 

 
 

Il s'est marié en 1847, à l'âge de 29 ans. En 1861, il vit avec sa femme et ses sept enfants, à 

Richibucto, Kent, Nouveau-Brunswick. Sa religion est catholique romaine. Il est un fermier. En 1871, il 

vit avec sa femme et ses dix enfants. En 1891, il vit avec sa femme et ses six enfants. En 1901, il vit 

avec sa femme, dans la maison de son fils et de la famille de son fils. Il a vécu jusqu'à 86 ans. 

  

Richibucto 

https://www.familysearch.org/tree/person/details/9V7W-RH1
https://www.familysearch.org/tree/person/details/L2TM-KKM
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/9J71-RK3 

 

 https://www.wikitree.com/wiki/Arsenault-2096 

  

https://www.familysearch.org/tree/person/details/9J71-RK3
https://www.wikitree.com/wiki/Arsenault-2096
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2.2.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/9J71-RK3 

 

  

https://www.familysearch.org/tree/person/timeline/9J71-RK3
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2.2.2  Mariage (1847) 

 

Avec son épouse Nathalie Daigle (1824-Décédée). 

 

https://familysearch.org/ark:/61903/1:1:QVBF-NTYH 

 

 
 

https://familysearch.org/ark:/61903/1:1:QVBF-NTYH
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2.2.3  Recensement du Canada (1861) 

Avec son épouse Nathalie Daigle (1824-Décédée). 

https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00224 

  

https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00224
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2.2.4  Recensement du Canada (1871) 

 

Avec son épouse Nathalie Daigle (1824-Décédée) et fille Marie Catherine Arsenault (1867-1942). 

 

https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00365 

 

 
  

https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00365
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2.2.5  Recensement du Canada (1891) 

 

Avec son épouse Nathalie Daigle (1824-Décédée) et fille Marie Catherine Arsenault (1867-1942). 

 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00385 

 
 

 
 

  

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00385
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2.2.6  Recensement du Canada (1901) 

Dans la maison de son fils David Arsenault, avec son épouse Nathalie Daigle (1824-Décédée). 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000026874 

 

https://www.familysearch.org/tree/person/details/KXZJ-LH1
https://www.ancestry.ca/imageviewer/collections/8826/images/z000026874
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2.2.7  Certificat De Décès (1904) 

 

https://familysearch.org/ark:/61903/1:1:XGHN-2ZZ 

 

 

https://familysearch.org/ark:/61903/1:1:XGHN-2ZZ
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2.2.8  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.3  Barriault, Marie Blanche (1843-Décédée) 
 

Fille de Jean Barrieau (Décédé) et Gertrude Savoie (Décédée), pas encore inclus dans ce document de 

généalogie. 

 

Epouse de François Joseph Daigle (1838-Décédé). 

 

Mère de Joseph François Daigle (1877-Décédé). 

 

Né le 7 août 1843, possibly à St. Louis de Kent, Québec. 

 

Décédée à une date incertaine, probablement à Saint-Charles-Borromée, Kent County, New Brunswick, 

Canada. 

 

 
 

Elle se marie en 1869, à l'âge de 25 ans. En 1871, elle vit avec son mari, sa fille, les parents de son 

mari et sa belle-sœur, à St Louis, Kent, Nouveau-Brunswick. Son mari est agriculteur. Nous ne savons 

pas quand elle est décédée. 

  

https://www.familysearch.org/tree/person/details/MVNR-B3T
https://www.familysearch.org/tree/person/details/MVNR-BQJ
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LTV8-GFL 

 

 https://www.wikitree.com/wiki/Barriault-93 

 

  

https://www.familysearch.org/tree/person/details/LTV8-GFL
https://www.wikitree.com/wiki/Barriault-93
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2.3.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV8-GFL 

 

 
 

2.3.2  Mariage (1969) 

 

Voir François Joseph Daigle (1838-Décédé). 

 

2.3.3  Recensement du Canada (1871) 

 

Voir François Joseph Daigle (1838-Décédé). 

https://www.familysearch.org/tree/person/timeline/LTV8-GFL
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2.3.4  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.4  Daigle, François Joseph (1838-Décédé) 
 

Fils de François Daigle (1800-Décédé) et Marguerite Richard (1799-1890), pas encore inclus dans ce 

document de généalogie. 

 

Epoux de Marie Blanche Barriault (1843-Décédée). 

 

Père de Joseph François Daigle (1877-Décédé). 

 

Né le juin 1838, probablement à St Charles, Kent, New Brunswick, Canada. 

 

Décédé à une date incertaine, probablement à St Charles, Kent, New Brunswick, Canada. 

 

 
 

En 1861, il vit avec sa mère veuve, ses cinq frères et sœurs et un domestique, à Palmerston, Kent, 

Nouveau-Brunswick. Sa religion est catholique romaine. Sa mère est agricultrice. Il se marie en 1869, à 

l'âge de 30 ans. En 1871, il vit avec sa femme, sa fille, sa mère, son frère et sa sœur, à St Louis, Kent, 

Nouveau-Brunswick. Il est un fermier. En 1891, il vit avec deux enfants. En 1911, il vit avec sa belle-

fille et quatre de ses enfants, à St Charles, Kent, Nouveau-Brunswick. Il a vécu au moins 72 ans. 

  

https://www.familysearch.org/tree/person/details/2HS6-CZ6
https://www.familysearch.org/tree/person/details/271N-9RZ
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LTV8-5NJ 

 

 https://www.wikitree.com/wiki/Daigle-2165 

 

  

https://www.familysearch.org/tree/person/details/LTV8-5NJ
https://www.wikitree.com/wiki/Daigle-2165
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2.4.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV8-5NJ 

 

 
 

https://www.familysearch.org/tree/person/timeline/LTV8-5NJ
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2.4.2  Recensement du Canada (1861) 

Dans la maison avec sa mère Marguerite Richard (1799-1890). 

https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00155 

 

 

https://www.familysearch.org/tree/person/details/271N-9RZ
https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00155
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2.4.3  Mariage (1869) 

 

Avec son épouse Marie Blanche Barriault (1843-Décédée). 

 

https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31310185 

 

  

https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31310185
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https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005418860_00345 

 

 
 

https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005418860_00345
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2.4.4  Recensement du Canada (1871) 

 

Avec sa mère Marguerite Richard (1799-1890) et son épouse Marie Blanche Barriault (1843-Décédée). 

 

https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00269 

 

  

https://www.familysearch.org/tree/person/details/271N-9RZ
https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00269
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2.4.5  Recensement du Canada (1891) 

 

Avec son fils Joseph François Daigle (1877-Décédé). 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00393 

  

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00393
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2.4.6  Recensement du Canada (1911) 

 

Avec sa brue Cédulie Huard (1872-Décédée) et petite-fille Marie Laura Alberta Daigle (1901-1954). 

 

https://www.ancestry.ca/imageviewer/collections/8947/images/e079_e001958499 

 

https://www.ancestry.ca/imageviewer/collections/8947/images/e079_e001958499
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2.4.7  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.5  Daigle, François Joseph (1868-1943) 
 

 
2 - François Joseph Daigle 

 

Fils de Louis Daigle (1831-1909) et Luce Daigle (1833-1903). 

 

Epouse de Marie Catherine Arsenault (1867-1942). 

 

Père de Joseph Antoine Daigle (1899-1988). 

 

Né le 29 février 1868, à Saint-Charles-Borromée, Kent County, New Brunswick, Canada. 

 

Décédé le 30 mai 1943 à Saint-Charles-Borromée, Kent County, New Brunswick, Canada. 
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En 1871, il vit avec ses parents et ses trois frères et sœurs, à St Louis, Kent, Nouveau-Brunswick. Sa 

religion est catholique romaine. Son père est agriculteur. En 1881, il vit avec ses parents et ses trois 

frères et sœurs. En 1892, il se marie, à l'âge de 24 ans. Il est agriculteur. En 1901, il vit avec sa 

femme, ses trois enfants et ses parents. En 1911, il vit avec sa femme et ses trois enfants, à St 

Charles, Kent, Nouveau-Brunswick, et possède 600 $ d'assurance-vie et 150 $ d'assurance accident ou 

maladie. En 1921, il vit avec sa femme, son fils et sa femme, et un neveu. Il a vécu jusqu'à 75 ans. « 

François Joseph (Joseph) (Jos) a été secrétaire de la Société agricole du Nouveau-Brunswick, Canada 

pendant 50 ans, et il avait la station expérimentale sur sa propriété » (utilisateur d'Ancestry wandaleo). 

 

Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LBWF-6KS 

 

 https://www.wikitree.com/wiki/Daigle-2161 

 

  

https://www.ancestry.ca/family-tree/person/tree/177738919/person/192324264213/hints
https://www.familysearch.org/tree/person/details/LBWF-6KS
https://www.wikitree.com/wiki/Daigle-2161
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2.5.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LBWF-6KS 

 

 
  

https://www.familysearch.org/tree/person/timeline/LBWF-6KS
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2.5.2  Recensement du Canada (1871) 

 

Voir Louis Daigle (1831-1909). 

 

2.5.3  Recensement du Canada (1881) 

 

Voir Louis Daigle (1831-1909). 
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2.5.4  Mariage (1892) 

 

Avec son épouse Marie Catherine Arsenault (1867-1942). 

 

https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005192712_00889 

 

  

https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005192712_00889
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https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005192712_00890 

 

https://www.ancestry.ca/imageviewer/collections/61511/images/FS_005192712_00890
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https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31300561 

 

  

https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31300561
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2.5.5  Recensement du Canada (1901) 

 

Avec son père Louis Daigle (1831-1909), sa mère Luce Daigle (1833-1903), et son épouse Marie Catherine Arsenault (1867-1942), et son 

fils Joseph Antoine Daigle (1899-1988). 

 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000026933 

 

  

https://www.ancestry.ca/imageviewer/collections/8826/images/z000026933
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2.5.6  Recensement du Canada (1911) 

 

Avec son épouse Marie Catherine Arsenault (1867-1942) et son fils Joseph Antoine Daigle (1899-1988). 

 

https://www.ancestry.ca/imageviewer/collections/8947/images/e079_e001958497 

 

  

https://www.ancestry.ca/imageviewer/collections/8947/images/e079_e001958497
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2.5.7  Recensement du Canada (1921) 

 

Avec son épouse Marie Catherine Arsenault (1867-1942), et son fils Joseph Antoine Daigle (1899-1988) et son épouse Marie Laura Alberta 

Daigle (1901-1954). 

 

https://www.ancestry.ca/imageviewer/collections/8991/images/1921_033-E002895377 

 

 

https://www.ancestry.ca/imageviewer/collections/8991/images/1921_033-E002895377
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2.5.8  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.6  Daigle, Joseph François (1877-Décédé) 
 

 
3 - Joseph François Daigle 

 

Fils de François Joseph Daigle (1838-Décédé) et Marie Blanche Barriault (1843-Décédée). 

 

Epoux de Cédulie Huard (1872-Décédée). 

 

Père de Marie Laura Alberta Daigle (1901-1954). 

 

Né le 20 octobre 1877 à Saint-Charles, Kent, New Brunswick, Canada. 

 

Décédé à une date incertaine, probablement à Saint-Charles, Kent, New Brunswick, Canada. 
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Son père était agriculteur. Il est baptisé en 1877. Il se marie en 1897 à Salem, Massachusetts, à l'âge 

de 19 ans. Il est déménageur. Il se remarie en 1902, à Saint-Charles, Kent, Nouveau-Brunswick. Il est 

maintenant agriculteur. En 1901, il vit avec sa femme et ses deux enfants, à St Louis, Kent, Nouveau-

Brunswick. Nous ne savons pas quand il est mort. 

 

Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LTV4-QBM 

 

 https://www.wikitree.com/wiki/Daigle-2160 

 

  

Saint-Louis 

https://www.familysearch.org/tree/person/details/LTV4-QBM
https://www.wikitree.com/wiki/Daigle-2160
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2.6.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV4-QBM 

 

 
  

https://www.familysearch.org/tree/person/timeline/LTV4-QBM
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2.6.2  Baptême (1877) 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/73b93056-

5617-4e32-81e4-93e2571bcec5 

 

 
 

  

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/73b93056-5617-4e32-81e4-93e2571bcec5
https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/73b93056-5617-4e32-81e4-93e2571bcec5


Généalogie: Daigle  2022-07-12 

  Page 50/132 

 

2.6.3  Recensement du Canada (1891) 

 

Voir François Joseph Daigle (1838-Décédé). 
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2.6.4  Mariage Registration & Certificate (1897 & 1902) 

 

Avec son épouse Cédulie Huard (1872-Décédée), d'abord au Massachusetts en 1897 puis de nouveau au Nouveau-Brunswick en 1902. 

 

https://familysearch.org/ark:/61903/1:1:N4HV-X3T 

 

  

https://familysearch.org/ark:/61903/1:1:N4HV-X3T
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https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31300509 

 

 
 

https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31300509
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https://familysearch.org/ark:/61903/1:1:QVBF-QYBD 

 

 
  

https://familysearch.org/ark:/61903/1:1:QVBF-QYBD
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https://familysearch.org/ark:/61903/1:1:QVBF-QYBN 

 

 
 

https://familysearch.org/ark:/61903/1:1:QVBF-QYBN
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2.6.5  Recensement du Canada (1901) 

 

Avec son épouse Cédulie Huard (1872-Décédée). 

 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000026912 

 

 
 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000026912
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2.6.6  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.7  Daigle, Joseph Antoine (1899-1988) 
 

 
4 - Joseph Antoine Daigle, Marie Laura Alberta Daigle, Joseph Zénon Daigle 

 

 
5 - Joseph Antoine Daigle 

 

Joseph Antoine Daigle 

Marie Laura Alberta Daigle 

Joseph Zénon Daigle 
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Fils de François Joseph Daigle (1868-1943) et Marie Catherine Arsenault (1867-1942). 

 

Epoux de Marie Laura Alberta Daigle (1901-1954). 

 

Père de Joseph Zénon Daigle (1934). 

 

Né le 14 mai 1899 à Saint Charles, Kent, New Brunswick, Canada. 

 

Décédé le 3 décembre 1988, probablement à Saint Charles, Kent, New Brunswick, Canada. 

 

 
 

Il est baptisé en 1899, en tant que catholique romain. En 1901, il vit avec ses parents, ses deux frères 

et sœurs et ses grands-parents, à St Louis, Kent, Nouveau-Brunswick. Son père est agriculteur. En 

1911, il vit avec ses parents et son  frère et sa sœur, à St-Charles de Kent, Nouveau-Brunswick. Sa 

sœur et son frère sont décédés à un jour d’intervalle en avril 1919 de la grippe espagnol . En  1921, il 

vit avec ses parents et son épouse.  Il est agriculteur « avec son père ».  Il s’est marié et il a eu 12 

enfants dont 9 enfants survivants. Il a été agriculteur durant la saison estivale et il a travailler comme 

débardeur au port de St-Jean Nouveau-Brunswick en dehors de la saison agricole.  Son épouse  Laura 

est décédée à 52 ans.  Il s’est marié en deuxième noce avec Delphine Richard en 1963. Il a vécu 

jusqu'à 89 ans.   

 

Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LTV8-NVY 

 https://www.wikitree.com/wiki/Daigle-2158 

  

Saint-Louis 

https://www.familysearch.org/tree/person/details/LTV8-NVY
https://www.wikitree.com/wiki/Daigle-2158
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2.7.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV8-NVY 

 
  

https://www.familysearch.org/tree/person/timeline/LTV8-NVY
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2.7.2  Birth Certificate & Registration (1899) 

 

https://familysearch.org/ark:/61903/1:1:XT3R-15J 

 

https://familysearch.org/ark:/61903/1:1:XT3R-15J
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https://familysearch.org/ark:/61903/1:1:ZNYH-5H3Z 

 

  

https://familysearch.org/ark:/61903/1:1:ZNYH-5H3Z
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2.7.3  Baptême (1899) 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364598/media/5ff6369a-f5ba-4d1a-9045-1f6d2f98cc10 

 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364598/media/5ff6369a-f5ba-4d1a-9045-1f6d2f98cc10
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2.7.4  Recensement du Canada (1901) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.7.5  Recensement du Canada (1911) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.7.6  Recensement du Canada (1921) 

 

Voir François Joseph Daigle (1868-1943). 
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2.7.7  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.8  Daigle, Joseph Zénon (1934) 
 

 
6 - Joseph Zénon Daigle 

 

Fils de Joseph Antoine Daigle (1899-1988) et Marie Laura Alberta Daigle (1901-1954). 

 

Epoux de Marie Rhéa April (1934). 

 

Père de Marie Rachel Christine Daigle (1962), Joseph Alain François Daigle (1964), Marie Nathalie 

Céline Daigle (1966), et Martin Jacques Daigle (1969). 

 

Né le juin 23, 1934, à Saint-Charles, Kent, New Brunswick, Canada. 



Généalogie: Daigle  2022-07-12 

  Page 66/132 

 

 
 

Edmundston 

Fredericton 

Richibucto 

Memramcook 
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https://en.wikipedia.org/wiki/Joseph_Daigle_(New_Brunswick_politician) 

https://fr.wikipedia.org/wiki/Joseph_Zenon_Daigle 

 

Joseph Zénon Daigle, CM QC est un avocat canadien et un ancien politicien et juge en chef du 

Nouveau-Brunswick. 

 

D'origine acadienne, Daigle est né à Saint-Charles, au Nouveau-Brunswick, et a fait ses études 

dans sa province natale. Il a obtenu un baccalauréat ès arts du Collège St. Joseph et un 

baccalauréat en droit civil de l'Université du Nouveau-Brunswick avant d'étudier le droit 

international public à l'Université de Paris en France. Il s'est lancé dans la pratique privée en 

1960 et a été juge à la Cour provinciale de 1967 à 1974, date à laquelle il est entré en politique. 

 

Lors des élections générales de 1974 au Nouveau-Brunswick, Daigle a été élu à l'Assemblée 

législative en tant que candidat du Parti libéral pour la nouvelle circonscription de Kent Nord. En 

1978, il devient chef du Parti libéral provincial et assume le rôle de chef de l'opposition à 

l'Assemblée. 

 

Lors des élections de 1978, Daigle a été personnellement réélu tout en menant son parti à une 

faible perte. Ses libéraux ont recueilli 44,36 pour cent du vote populaire, à peine 0,03 pour cent 

de moins que les progressistes-conservateurs vainqueurs, et ont remporté 28 sièges contre 30 

pour les conservateurs. 

 

Daigle revient à la pratique du droit. En 1982, il a été nommé juge de la Cour du Banc de la 

Reine du Nouveau-Brunswick et en a été nommé juge en chef en 1994. Il a été nommé juge en 

chef du Nouveau-Brunswick en 1998, jusqu'en 2003, date à laquelle il a été élu surnuméraire. 

 

En 2004, le gouvernement du Canada a nommé Daigle président de sa Commission de 

délimitation des circonscriptions électorales de Miramichi et Acadie—Bathurst, qui a réglé avec 

succès ce qui était devenu une question politique litigieuse. 

 

En décembre 2015, il a été nommé membre de l'Ordre du Canada. 

 

Sites de généalogie (notez que les personnes vivantes ne sont pas visibles tant que vous n’avez pas de 

compte sur le site et n’avez pas reçu l’autorisation d’accéder à la page par le créateur, dans ce cas 

William Mott Stewart, ou recréez la page sous votre propre compte): 

 

https://www.familysearch.org/tree/person/details/G8D8-NX2 

 

https://www.wikitree.com/wiki/Daigle-2157 

 

  

https://en.wikipedia.org/wiki/Joseph_Daigle_(New_Brunswick_politician)
https://fr.wikipedia.org/wiki/Joseph_Zenon_Daigle
https://www.familysearch.org/tree/person/details/G8D8-NX2
https://www.wikitree.com/wiki/Daigle-2157
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2.8.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/G8D8-NX2 

 

 
 

https://www.familysearch.org/tree/person/timeline/G8D8-NX2
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2.8.2  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.9  Daigle, Louis (1831-1909) 
 

 
7 - Luce Daigle, Louis Daigle 

 

Fils de François Daigle (1800-Décédé) et Marguerite Richard (1799-1890), pas encore inclus dans ce 

document de généalogie. 

 

Epoux de Luce Daigle (1833-1903). 

 

Père de François Joseph Daigle (1868-1943). 

 

Né le 9 mars 1831 à Saint-Charles, Kent, New Brunswick, Canada. 

 

Décédé le 15 avril 1909 à Saint-Charles, Kent, New Brunswick, Canada. 

 

https://www.familysearch.org/tree/person/details/2HS6-CZ6
https://www.familysearch.org/tree/person/details/271N-9RZ
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Il se marie en 1858, à l'âge de 27 ans. En 1861, il vit avec sa femme et ses deux enfants, à 

Palmerston, Kent, Nouveau-Brunswick. Son catholique romain. Il est un fermier. En 1871, il vit avec sa 

femme et ses quatre enfants, à St Louis, Kent, Nouveau-Brunswick. En 1881, il vit avec sa femme et 

ses cinq enfants. En 1891, il vit avec sa femme et ses trois enfants, avec un de ses fils et sa femme 

habitant à côté.  En 1901, il vit avec sa femme dans la maison de son fils et de sa famille.  Il a vécu 

jusqu'à 78 ans. 
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LZD2-LQB 

 

 https://www.wikitree.com/wiki/Daigle-2162 

 

  

https://www.familysearch.org/tree/person/details/LZD2-LQB
https://www.wikitree.com/wiki/Daigle-2162
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2.9.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LBWF-6KS 

 

 
  

https://www.familysearch.org/tree/person/timeline/LBWF-6KS
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2.9.2  Mariage (1858) 

 

Avec son épouse Luce Daigle (1833-1903). 

 

https://familysearch.org/ark:/61903/1:1:QVBF-J7DZ 

 

  

https://familysearch.org/ark:/61903/1:1:QVBF-J7DZ
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2.9.3  Recensement du Canada (1861) 

 

Avec son épouse Luce Daigle (1833-1903). 

  

https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00154 

 

 
  

https://www.ancestry.ca/imageviewer/collections/1570/images/4108515_00154
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2.9.4  Recensement du Canada (1871) 

 

Avec son épouse Luce Daigle (1833-1903) et son fils François Joseph Daigle (1868-1943). 

 

https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00265 

 

  

https://www.ancestry.ca/imageviewer/collections/1578/images/4396276_00265
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2.9.5  Recensement du Canada (1881) 

 

Avec son épouse Luce Daigle (1833-1903) et son fils François Joseph Daigle (1868-1943). 

 

https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13184-00607 

 

  

https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13184-00607


Généalogie: Daigle  2022-07-12 

  Page 79/132 

 

 

2.9.6  Recensement du Canada (1891) 

 

Avec son épouse Luce Daigle (1833-1903). 

 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00390 

 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148102-00390
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2.9.7  Recensement du Canada (1901) 

 

Voir François Joseph Daigle (1868-1943). 

 

2.9.8  Certificat De Décès (1909) 

 

https://familysearch.org/ark:/61903/1:1:XGH1-FP2 

 

 
  

https://familysearch.org/ark:/61903/1:1:XGH1-FP2
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2.9.9  Tombe (1909) 

 

https://www.findagrave.com/memorial/132533971/louis-g-daigle 

 

Louis G Daigle 

 

Birth  1831 

New Brunswick, Canada 

 

Death  15 Apr 1909 (aged 77-78) 

Saint-Charles, Kent County, New Brunswick, Canada 

 

Burial   

St. Charles Roman Catholic Cemetery 

Saint-Charles, Kent County, New Brunswick, Canada 

 

Memorial ID  132533971 · View Source 

 

http://i215.photobucket.com/albums/cc26/AFCRoots/St-Charles-de-Kent-Cemetery/P1180715.jpg 

 

https://www.findagrave.com/memorial/132533971/louis-g-daigle
http://i215.photobucket.com/albums/cc26/AFCRoots/St-Charles-de-Kent-Cemetery/P1180715.jpg
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2.9.10  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.10  Daigle, Luce (1833-1903) 
 

Fille de Jean Maxime Daigle (1785-1838) et Marie Osite Babin (1804-Décédée), pas encore inclus dans 

ce document de généalogie. 

 

Epouse de Louis Daigle (1831-1909). 

 

Mère de François Joseph Daigle (1868-1943). 

 

Né le 6 décembre 1833 à Saint-Charles, Kent, New Brunswick, Canada. 

 

Décédée le 31 octobre 1903 à Saint-Charles, Kent County, New Brunswick, Canada. 

 

 
 

Elle se marie en 1858, à l'âge de 24 ans. Elle est catholique romaine. En 1861, elle vit avec son mari et 

ses deux enfants, à Palmerston, Kent, Nouveau-Brunswick. Son mari est agriculteur. En 1871, elle vit 

avec son mari et ses quatre enfants, à St Louis, Kent, Nouveau-Brunswick. En 1881, elle vit avec son 

mari et ses cinq enfants. En 1891, elle vit avec son mari et ses trois enfants, avec un de ses fils et sa 

femme habitant à côté. En 1901, elle vit avec son mari, avec son fils et sa famille. Elle a vécu jusqu'à 

69 ans. 

 

Sites de généalogie: 

 

https://www.familysearch.org/tree/person/details/M1V3-4SF
https://www.familysearch.org/tree/person/details/LCTT-CRZ
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 https://www.familysearch.org/tree/person/details/LBHB-MVR 

 

 https://www.wikitree.com/wiki/Daigle-2163 

 

  

https://www.familysearch.org/tree/person/details/LBHB-MVR
https://www.wikitree.com/wiki/Daigle-2163
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2.10.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LBHB-MVR 

 

 
  

https://www.familysearch.org/tree/person/timeline/LBHB-MVR
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2.10.2  Mariage (1858) 

 

Voir Louis Daigle (1831-1909). 

 

2.10.3  Recensement du Canada (1861) 

 

Voir Louis Daigle (1831-1909). 

 

2.10.4  Recensement du Canada (1871) 

 

Voir Louis Daigle (1831-1909). 

 

2.10.5  Recensement du Canada (1881) 

 

Voir Louis Daigle (1831-1909). 

 

2.10.6  Recensement du Canada (1891) 

 

Voir Louis Daigle (1831-1909). 

 

2.10.7  Recensement du Canada (1901) 

 

Voir François Joseph Daigle (1868-1943). 
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2.10.8  Tombe (1903) 

 

https://www.findagrave.com/memorial/132533670/lucie-daigle 

 

Lucie Daigle 

Birth  1 Dec 1833 

Saint-Charles, Kent County, New Brunswick, Canada 

 

Death  31 Oct 1903 (aged 69) 

Saint-Charles, Kent County, New Brunswick, Canada 

 

Burial   

St. Charles Roman Catholic Cemetery 

Saint-Charles, Kent County, New Brunswick, Canada 

Memorial ID  132533670 · View Source 

 

http://i215.photobucket.com/albums/cc26/AFCRoots/St-Charles-de-Kent-Cemetery/P1180714.jpg 

 

 

https://www.findagrave.com/memorial/132533670/lucie-daigle
http://i215.photobucket.com/albums/cc26/AFCRoots/St-Charles-de-Kent-Cemetery/P1180714.jpg
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2.10.9  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.11  Daigle, Marie Laura Alberta (1901-1954) 
 

 
8 - Marie Laura Alberta Daigle 

 

Fille de Joseph François Daigle (1877-Décédé) et Cédulie Huard (1872-Décédée). 

 

Epouse de Joseph Antoine Daigle (1899-1988). 

 

Mère de Joseph Zénon Daigle (1934). 

 

Né le 23 décembre 1901 à Saint Charles, Kent, New Brunswick, Canada. 

 

Décédée le 11 mai 1954 à Saint Charles, Kent, New Brunswick, Canada. 
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En 1911, elle vit avec ses parents et ses trois frères et sœurs, à St Charles, Kent, Nouveau-Brunswick. 

Son père est agriculteur. En 1921, elle vit avec son mari, chez les parents de son mari. Son mari est 

agriculteur. Elle a vécu jusqu'à 52 ans. 

 

Sites de généalogie: 

 

https://www.familysearch.org/tree/person/details/LTV8-JK7 

 

https://www.wikitree.com/wiki/Daigle-2159  

https://www.familysearch.org/tree/person/details/LTV8-JK7
https://www.wikitree.com/wiki/Daigle-2159
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2.11.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV8-JK7 

 

 
  

https://www.familysearch.org/tree/person/timeline/LTV8-JK7
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2.11.2  Birth Certificate & Registration (1901) 

 

https://familysearch.org/ark:/61903/1:1:XTQ3-DWG 

 

 

https://familysearch.org/ark:/61903/1:1:XTQ3-DWG
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https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31301316 

 

https://www.ancestry.ca/imageviewer/collections/1110/images/d13p_31301316
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2.11.3  Recensement du Canada (1911) 

 

Voir François Joseph Daigle (1838-Décédé). 

 

2.11.4  Recensement du Canada (1921) 

 

Voir Joseph Daigle (1868-1943). 
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2.11.5  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.12  Daigle, Nathalie (1824-Décédée) 
 

Fille de Pierre Luc Daigle (1802-1884) et Anne Blanche Robichaud (1804-Décédée), pas encore inclus 

dans ce document de généalogie. 

 

Epouse de Pierre Arseneau (1817-1904). 

 

Mère de Marie Catherine Arsenault (1867-1942). 

 

Né le 15 décembre 1824 à Saint-Charles, Kent, New Brunswick, Canada. 

 

Décédée à une date incertaine, probablement à Saint-Charles, Kent, New Brunswick, Canada. 

 

 
 

Elle se marie en 1847, à l'âge de 22 ans. En 1861, elle vit avec son mari et ses sept enfants, à Kent, 

Nouveau-Brunswick. Son mari est agriculteur. En 1871, elle vit avec son mari et ses dix enfants, à 

Richibucto, Kent, Nouveau-Brunswick. En 1901, elle vit avec son mari, avec son fils et sa famille. Elle a 

vécu au moins 76 ans. 

  

https://www.familysearch.org/tree/person/details/LZD2-LGN
https://www.familysearch.org/tree/person/details/LZP6-FBJ
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LH3K-J8B 

 

 https://www.wikitree.com/wiki/Daigle-2164 

 

  

https://www.familysearch.org/tree/person/details/LH3K-J8B
https://www.wikitree.com/wiki/Daigle-2164
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2.12.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LH3K-J8B 

 

 
  

https://www.familysearch.org/tree/person/timeline/LH3K-J8B
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2.12.2  Mariage (1847) 

 

Voir Pierre Arseneau (1817-1904). 

 

2.12.3  Recensement du Canada (1861) 

 

Voir Pierre Arseneau (1817-1904). 

 

2.12.4  Recensement du Canada (1871) 

 

Voir Pierre Arseneau (1817-1904). 

 

2.12.5  Recensement du Canada (1901) 

 

Voir Pierre Arseneau (1817-1904). 
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2.12.6  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.13  Huard, Cédulie (1876-Décédée) 
 

 
9 - Cédulie Huard 

 

Fille de Joseph Huard (1839-1923) et Rose-Délima St-Laurent (1848-1919). 

 

Epouse de Joseph François Daigle (1877-Décédé). 

 

Mère de Marie Laura Alberta Daigle (1901-1954). 

 

Né le 4 septembre 1876 à Rimouski, Rimouski, Québec, Canada, 

 

Décédée à une date incertaine, probablement à Saint Charles, New Brunswick, Canada. 
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Elle est baptisée en 1872, en tant que catholique romaine. En 1881, elle vit avec ses parents et ses cinq 

frères et sœurs, à St Anaclet, Rimouski, Québec. Son père est agriculteur. En 1891, elle vit avec ses 

parents et neuf frères et sœurs, à Neigette, Rimouski, Québec. Elle se marie en 1897 à Salem, 

Massachusetts, à l'âge de 21 ans. Son mari est déménageur. Elle se remarie en 1902, à Saint-Charles, 

Kent, Nouveau-Brunswick. Son mari est maintenant agriculteur. En 1901, elle vit avec son mari et ses 

deux enfants, à St Louis, Kent, Nouveau-Brunswick. En 1911, elle vit avec quatre enfants avec son 

beau-père. Elle a vécu au moins 35 ans.  

Neigette 
Saint-Anaclet 

Saint-Louis 
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LTV4-7F4 

 

 https://www.wikitree.com/wiki/Huard-468 

 

  

https://www.familysearch.org/tree/person/details/LTV4-7F4
https://www.wikitree.com/wiki/Huard-468
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2.13.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LTV4-7F4 

 

 
  

https://www.familysearch.org/tree/person/timeline/LTV4-7F4
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2.13.2  Baptême (1872) 

 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/c915f843-

2a83-444a-937a-96fd86b5a75d 

 

 
 

2.13.3  Recensement du Canada (1881) 

 

Voir Joseph Huard (1839-1923). 

 

2.13.4  Recensement du Canada (1891) 

 

Voir Joseph Huard (1839-1923). 

 

2.13.5  Mariage Registration & Certificate (1897) 

 

Voir Joseph François Daigle (1877-Décédé). 

 

2.13.6  Recensement du Canada (1901) 

 

Voir Joseph François Daigle (1877-Décédé). 

 

2.13.7  Recensement du Canada (1911) 

 

Voir François Joseph Daigle (1838-Décédé). 

https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/c915f843-2a83-444a-937a-96fd86b5a75d
https://www.ancestry.ca/mediaui-viewer/tree/154732543/person/152043364589/media/c915f843-2a83-444a-937a-96fd86b5a75d
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2.13.8  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.14  Huard, Joseph (1839-1923) 
 

Fils de Joseph Huard (1810-Décédé) et Marie Josephte Roy (1820-Décédée), pas encore inclus dans ce 

document de généalogie. 

 

Epoux de Rose-Délima St-Laurent (1848-1919). 

 

Père de Cédulie Huard (1872-Décédée). 

 

Né le 10 septembre 1839, probablement à St-Anaclet-de-Lessard, Rimouski, Québec, Canada. 

 

Décédé le 17 mars 1923 à St-Anaclet-de-Lessard, Rimouski, Québec, Canada. 

 

 
 

Il se marie en 1866, à l'âge de 26 ans. En 1871, il vit avec sa femme et ses trois enfants, à St Anaclet, 

Rimouski-Ouest, Québec. Il est catholique romain. Il est un fermier. En 1881, il vit avec sa femme et 

ses six enfants. En 1891, il vit avec sa femme et ses dix enfants, à Neigette, Rimouski, Québec. En 

1901, il vit avec sa femme et ses six enfants. En 1911, il vit avec sa femme dans la maison de son fils. 

Il a vécu jusqu'à 83 ans. 

  

Saint-Hubert 

Neigette 

https://www.familysearch.org/tree/person/details/LWJC-LMZ
https://www.familysearch.org/tree/person/details/M1L9-1B8
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Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LVHK-N7V 

 

 https://www.wikitree.com/wiki/Huard-469 

 

  

https://www.familysearch.org/tree/person/details/LVHK-N7V
https://www.wikitree.com/wiki/Huard-469
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2.14.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LVHK-N7V 

 

 
  

https://www.familysearch.org/tree/person/timeline/LVHK-N7V
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2.14.2  Mariage (1866) 

 

Avec son épouse Rose-Délima St-Laurent (1848-1919). 

 

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_17230460 

 

 
 

 

https://www.ancestry.ca/imageviewer/collections/1091/images/d13p_17230460
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2.14.3  Recensement du Canada (1871) 

 

Avec son épouse Rose-Délima St-Laurent (1848-1919). 

https://www.ancestry.ca/imageviewer/collections/1578/images/4395568_00668 

  

https://www.ancestry.ca/imageviewer/collections/1578/images/4395568_00668
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2.14.4  Recensement du Canada (1881) 

 

Avec son épouse Rose-Délima St-Laurent (1848-1919) et sa fille Cédulie Huard (1872-Décédée). 

 

https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13188-00510 

 

  

https://www.ancestry.ca/imageviewer/collections/1577/images/31229_C_13188-00510
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2.14.5  Recensement du Canada (1891) 

 

Avec son épouse Rose-Délima St-Laurent (1848-1919) et sa fille Cédulie Huard (1872-Décédée). 

 

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148220-00139 

 

  

https://www.ancestry.ca/imageviewer/collections/1274/images/30953_148220-00139
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2.14.6  Recensement du Canada (1901) 

 

Avec son épouse Rose-Délima St-Laurent (1848-1919). 

 

https://www.ancestry.com/imageviewer/collections/8826/images/z000167676 

 

  

https://www.ancestry.com/imageviewer/collections/8826/images/z000167676
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2.14.7  Recensement du Canada (1911) 

 

Dans la maison du son fils Philippe Huard, avec son épouse Rose-Délima St-Laurent (1848-1919). 

 

https://familysearch.org/ark:/61903/1:1:QVBC-19J5 

 

https://www.familysearch.org/tree/person/details/GM4N-GP8
https://familysearch.org/ark:/61903/1:1:QVBC-19J5
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2.14.8  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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2.15  St-Laurent, Rose-Délima (1848-1919) 
 

Fille de Calixte-Marcellin St-Laurent (1807-1868) et Marguerite Lévèque (1814-1888), pas encore inclus 

dans ce document de généalogie. 

 

Epouse de Joseph Huard (1839-1923). 

 

Mère de Cédulie Huard (1872-Décédée). 

 

Né le 26 août 1848, probablement à Saint-Germain-de-Rimouski, Rimouski, Québec, Canada. 

 

Décédée le 6 novembre 1919 à St-Anaclet-de-Lessard, Rimouski, Québec, Canada. 

 

 
 

Elle se marie en 1866, à l'âge de 18 ans. En 1871, elle vit avec son mari et ses trois enfants, à St 

Anaclet, Rimouski-Ouest, Québec. Elle est catholique romaine. Son mari est agriculteur. En 1881, elle 

vit avec son mari et ses six enfants. En 1891, elle vit avec son mari et ses dix enfants, à Neigette, 

Rimouski, Québec. En 1901, elle vit avec son mari et ses six enfants. En 1911, elle vit avec son mari 

dans la maison de son fils. Elle a vécu jusqu'à 71 ans. 

 

Sites de généalogie: 

 

 https://www.familysearch.org/tree/person/details/LVHK-N7V 

 

 https://www.wikitree.com/wiki/St._Laurent-117  

Saint-Anaclet 

https://www.familysearch.org/tree/person/details/LH63-MYP
https://www.familysearch.org/tree/person/details/K2BQ-2F2
https://www.familysearch.org/tree/person/details/LVHK-N7V
https://www.wikitree.com/wiki/St._Laurent-117
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2.15.1  Chronologie 

 

https://www.familysearch.org/tree/person/timeline/LHJD-NXV 

 

 
  

https://www.familysearch.org/tree/person/timeline/LHJD-NXV
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2.15.2  Mariage (1866) 

 

Voir Joseph Huard (1839-1923). 

 

2.15.3  Recensement du Canada (1871) 

 

Voir Joseph Huard (1839-1923). 

 

2.15.4  Recensement du Canada (1881) 

 

Voir Joseph Huard (1839-1923). 

 

2.15.5  Recensement du Canada (1891) 

 

Voir Joseph Huard (1839-1923). 

 

2.15.6  Recensement du Canada (1901) 

 

Voir Joseph Huard (1839-1923). 

 

2.15.7  Recensement du Canada (1911) 

 

Voir Joseph Huard (1839-1923). 
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2.15.8  Ancêtres 

Six générations d’ancêtres lorsqu’elles sont disponibles sur FamilySearch.org à partir d’octobre 2021, voir FamilySearch.org pour plus 

d’informations. 
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3.  Using This Document 
 

The following sections provide information on using, modifying, and printing this document.  You can 

get a soft-copy that you can update and modify yourself from https://williamstewart.com/ancestry/ 

 

Note that you can keep multiple copies of this document open at the same time in Word by selecting 

View > Window > New Window.  You can then keep your focus in one place in one copy, and jump 

around in the other copies. 

 

3.1  Genealogy Websites & Links 
 

The family tree in this document is primarily maintained in FamilySearch.org, a free site sponsored by 

the Church of Latter Day Saints.  Much of the information is also available in Wikitree.com, and links to 

Wikitree have also been included.  All this information is available to anyone with a free account on 

these sites. 

 

Ancestry.com also provides a free membership option, however only paid accounts can access source 

documents.  A paid subscription might be worth it if you are doing a lot of research, since Ancestry.com 

has many source documents not available in FamilySearch.org.  I paid for a six month subscription, 

worked steadily to create this document, and will not need to renew my subscription.  Fortunately, you 

do not need a paid account to create a family tree, and if you do subscribe to a paid account your tree 

will still remain available to you once your paid subscription ends and you revert to a free account.  

However, you will lose access to the source documents.  Therefore, any applicable source documents 

found on Ancestry.com have been copied directly into this document, and a link to the source page 

included for completeness.   

 

Note that if you copy source links from Ancestry.com, it must be in a generic form that will be available 

from any paid Ancestry.com account.  That is, any links to sources on Ancestry.com that include a 

person ID or tree ID will only be available from your account and not be accessible by others, even if 

their account is paid.  However, you can often extract a link to the source document that will be 

accessible to others (with a paid Ancestry subscription) as follows. 

 

Take the hint to the Canada Census 1901 for William Albert Mott as an example.  From your paid 

Ancestry.com account, let us say you access the hints page and click on that hint.  That takes you to a 

page that includes an option to view the hint.  If you then click on the document, or click on View, it 

takes you to a separate page that shows the image for the census page, with a URL that looks 

something like the following: 

 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771?treeid=177738919&perso

nid=192311829107&hintid=&usePUB=true&usePUBJs=true&pId=11479208 

 

Note that this includes a “treeid” and “personid” that will be specific to your paid Ancestry.com account, 

and not accessible to others.  However, if you click in the web page address bar, and select just the 

part of the URL before the “?”, you get a generic standalone link to that census page that should be 

accessible to anyone with a currently paid Ancestry.com account: 

 

https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771 

 

Wherever possible, links to Ancestry.com sources in this document are in this generic format.   

 

3.2  Magnifying and Uncropping Images 
 

Some of the source documents may be difficult to read when printed.  However, in the soft-copy of this 

document you can often see more detail simply by zooming into the page.  Zoom options are usually 

https://williamstewart.com/ancestry/
http://familysearch.org/
http://wikitree.com/
http://ancestry.com/
https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771?treeid=177738919&personid=192311829107&hintid=&usePUB=true&usePUBJs=true&pId=11479208
https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771?treeid=177738919&personid=192311829107&hintid=&usePUB=true&usePUBJs=true&pId=11479208
https://www.ancestry.ca/imageviewer/collections/8826/images/z000028771
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available under an application menu such as View, or on most computers simply by holding down the 

Ctrl key and then using the mouse scroll wheel to zoom in and out as desired. 

 

Most of the source document images have been cropped to enlarge the relevant portion as much as 

possible.  However the full underlying image is still available, so if you have access to the Microsoft 

Word version of this document and wish to see the rest of the image for some reason, you can uncrop 

an image by right clicking on the image, selecting the option Crop, and then dragging the crop handles 

on the middle of each side of the image outwards.  You can then copy or save the image to your 

desktop and import it into other documents at full original size if you wish.  

 

3.3  Creating Your Own Document 
 

If you wish to create your own document with some of the information from this document, there is a 

better approach than copying information from this document into a new document.  Instead, make a 

copy of this document file on your computer, then change the file name to whatever you wish, then 

open that copy and delete any information you don’t want, and then add new information as desired.  

Modifying a copy of this document works better since it already has many of the styles set, so for 

example the headings show properly, the section headers and footers are continuous through the 

document, and the table of contents is formatted nicely, which can take a lot of work to set up in a 

brand new document.  Also, this document is already set to not compress embedded images, so images 

can be zoomed in to see additional detail. 

 

If you wish to add new landscape pages, such as used for many of the census documents in this 

document, proceed as described below.  One you know how to do this, you can do it in seconds. 

 

First create a new section by entering a section break, some blank lines, another section break, and 

then go back and set the middle part between the section breaks to be in landscape mode: 

 

• Make sure the paragraph indicator is turned on, from Home > Paragraph > “¶”    

• Layout > Page Setup > Breaks > Next Page 

• Press return several times to create some blank lines. 

• Layout > Page Setup > Breaks > Next Page 

• Arrow up before the second section break to the previous page with the blank lines. 

• Layout > Page Setup > Orientation > Landscape 

 

Then make sure the headers and footers will carry over from the previous sections.  If you are just 

adding a new section to a copy you made of this document, as recommended, then the following should 

already be set properly.  But you might want to check the first time to make sure. 

 

• Double-click in the header of the new section you just made to put your mouse in the header, 

and make sure the following button is selected: 

Header and Footer > Navigation > Link to Previous 

• Double-click in the footer and make sure the same button is selected: 

Header and Footer > Navigation > Link to Previous 

• Double check both the header and footer after the new section by repeating the above steps in 

the document after the new section you just added. 

 

If you are modifying a copy of this document, the following should not be an issue.  However, if you 

ever find the page number is restarting in some section, perhaps in a new landscape section you just 

added or the one after it, you can fix it by double-clicking to put your mouse in that footer, and select: 

 

• Header and Footer > Header and Footer > Page Number > Format Page Numbers 

• Then make sure the checkbox is selected “Continue from previous section” 

 

Finally, make sure the total page numbers are correct.  When a Word document has multiple portrait 

and landscape sections, there is no simple way to make sure the total page numbers is correct, the 



Généalogie: Daigle  2022-07-12 

  Page 129/132 

number Y at the end of “Page X/Y” in the footer.  This must be done with a bookmark that tells the 

page numbering how many total pages the document has.  This bookmark and the page numbering 

defaults are already set up in this document.  All you have to do is make sure you don’t delete the line 

which has the bookmark, which looks like this “I”.  That is, don’t delete the last line in this section, the 

line clearly labelled “[END OF DOCUMENT - DO NOT DELETE THIS PAGE NUMBER BOOKMARK]”. 

 

If you cannot see the “I” bookmark icon on that line, make sure you have selected File > Options > 

Advanced > Show Document Content > Show bookmarks. 

 

Finally, always remember to right-click on the Table of Contents and the List of Images at the beginning 

of the document and select Update after any document changes to make sure they are complete and 

the page numbering is correct. 

 

3.4  Adding New People 
 

You can research the genealogy websites and add people and information to a copy of this document if 

you wish.  Be prepared to take time to learn the sites, and then research the people you are interested 

in and collect the information.  If you make updates to the information on FamilySearch.org or 

Wikitree.com, note that you have a special responsibility to make extra sure it is accurate, since those 

sites are shared with the world. 

 

First create accounts on the sites you are interested in, FamilySearch.org and/or Wikitree.com.  If you 

wish access to the significant number of sources available on Ancestry.com, you can create a paid 

account there as well.  You can start with one month on Ancestry.com, and then if desired upgrade to a 

six month or one year membership.  Remember that you retain access to your family tree on 

Ancestry.com if you stop paying for an account, however you will no longer have access to the sources, 

so if you wish to keep the sources you should download them. 

 

Spend some time exploring and getting used to using each site.  Know how to show the tree view on 

each site.  It can be helpful to use multiple browser tabs so you can keep one page open and research 

other pages in other tabs.  Remember, you can open website pages in a separate tab in your browser 

by right-clicking on a link and selecting “Open link in new tab”, or on some computers if your mouse 

supports it simply by clicking the link with your scroll wheel. 

 

On any of these sites, once you have entered yourself, your parents, and your grandparents, the sites 

might start suggesting others farther back, and then connect to the rest of the tree that is available in 

their database.  Ancestry.com will sometimes show you a “Potential” indicator.  On Ancestry.com, once 

you have a person entered, check out the “hints” tab.  Especially check out hints to other Ancestry 

profiles, then check the box to select all the other profiles, review them, and add any people that will 

extend your tree, such as parents of the person you are working on.  You will then get your own copy of 

these people added to your tree, since Ancestry.com does not share profiles with others.  When 

reviewing other people from other Ancestry.com profiles through a hint, note that any information that 

is new to your tree, such as more complete dates or places, will be shown as new on the left of the 

review page on the other person profiles.  You can select or unselect the checkboxes for these 

individual elements of information to add or choose not to add this information as you wish. 

 

On FamilySearch and Wikitree, when you enter a new person, such as a great grandparent, if you have 

enough information entered, such as name and birth and death dates, the site will suggest existing 

people that might be a match.  On FamilySearch.org you can also enter the person’s parents or the 

name of their spouse to help the site see if the person is already in the database.  If the site suggests 

anyone that might be a match for the new person you are considering adding, always check out these 

other people, with right-click and open in new tab to investigate them further.  Whenever appropriate 

make sure you select an existing person if they match, since on FamilySearch and Wikitree everyone 

works on the same and hopefully accurate tree, and you don’t want to create duplicates of existing 

person profiles.  All the work you do on FamilySearch and Wikitree is shared with the world, so put in 
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extra effort to only enter accurate information and make any changes to existing information you find 

very carefully. 

 

On FamilySearch and Wikitree, if you do create a duplicate person by mistake, you can then merge 

them into the right profile.  If you discover duplicates made by someone else, you can merge them into 

one profile.  Merging profiles makes a lot of changes, so much be done especially carefully.  If you do 

any merging of profiles, make sure you understand the function very well, review all the information on 

both profiles to make sure the merge is absolutely the right thing to do, and then proceed carefully. 

 

On all three sites, make sure any dates and locations you enter are “standardized”.  That is, when you 

enter a date or location, the site will suggest a standard format.  Make sure you click on that 

standardized format to select it, so the site can recognize and then use the date or location properly. 

 

FamilySearch and Ancestry.com have the most complete set of sources for people farther back.  Review 

the “Sources” on FamilySearch and “Hints” on Ancestry.  Again, use the multiple browser tab trick - 

open these sources on other browser tabs so you don’t lose your current page, with right-click and open 

in new tab, or click the link with the mouse scroll wheel.  If the source is applicable, you can download 

it if desired, on FamilySearch simply by clicking the download button, and on Ancestry by clicking the 

little hammer and screwdriver icon and then selecting download.  You can then open the image file with 

your favorite image application, perhaps just by dragging it on top of a browser window since browsers 

will open images, then copy the image (perhaps by right-clicking and selecting Copy), and then paste it 

into your Word document.  You can then right-click the image and select “Crop” to crop it.  If you wish 

to resize the image, you sometimes have to hold down the Shift key before you drag a corner or edge, 

to make sure the image says the same proportion as you resize it.  

 

3.5  Intra-Document Links 
 

There are many links between sections of this document, for example between sections for parents and 

children.  There are also links from census references for one person to the subsection of the head of 

household where the census document can be found, to avoid duplicating information. 

 

These intra-document links can be created easily, by selecting the text you wish to link, and then either 

Ctrl-k or Insert > Links > Link. 

 

Then from the window that pops up, select “Place in this document” on the left, scroll to the section you 

wish to link to on the right, and select that section heading. 

 

Once you have a link, you can copy it and paste it elsewhere, and the link will copy too. 

 

Once you create a link to a section heading, you can change the text of the heading, or change the 

level by for example changing it from Heading 2 to Heading 3.   

 

However, while you can copy and paste links if you have multiple places you want to put a link, you 

should not copy a section heading itself and paste it elsewhere, since now Word does not know which 

heading any already created links should point at.  Similarly, never click in the middle of a section 

heading and press Return to split a heading into two headings, since this confuses Microsoft Word, and 

any intra-document links you have already created to that heading might no longer work.  (Neither of 

these problems should commonly occur, because most people have no need to copy or split headings, 

however just be aware of the problems that can occur if you do.) 

 

3.6  Ancestor Fan Charts 
 

The six generation fan charts in the final Ancestor subsections for each person are from 

FamilySearch.org, and take a couple steps to be inserted in a Microsoft Word document with high 

resolution so the chart can be zoomed into for better readability.  The following steps seem detailed, 
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but once you have done it a couple times it becomes easy, and is the only way I know of to get these 

fan charts into Word in high resolution zoomable format. 

 

First, install the very useful free open source office suite http://LibreOffice.org. 

 

Then the simplest way to create the fan chart is as follows: from your FamilySearch.org account, from 

the “Details” page of a person you wish to generate a fan chart, click “Fan Chart” from the print list on 

the bottom right of the page.  Or click “View tree” from the top right, then select “Fan Chart” from the 

options on the top left, then select “Print” from the options on the top right.  This will create a PDF file 

containing the fan chart. 

 

Then open the PDF file of the fan chart with LibreOffice.  This can be done in one of two ways.  (1) 

Either open any LibreOffice application, such as LibreOffice Writer or Draw, select File > Open, and then 

find the fan chart PDF file you just created and open it.  (2) Or simply drag the fan chart PDF file onto 

the top border bar of any open LibreOffice application. 

 

This will open the PDF with the LibreOffice Draw application.  Then: 

 

• Select the fan chart with Ctrl-a  

• Export it in the highest resolution Encapsulated Postscript format, by selecting File > Export… 

• Choose “EPS - Encapsulated Postscript” from “Save as type” 

• Check the “Selection” box to export just the selected fan chart. 

• Save the file. 

 

You have now created a very high resolution file containing that fan chart.  Now, to get it into Word, 

first open the EPS file you just created with LibreOffice Draw.  On some systems, simply double-clicking 

the file will open it with LibreOffice Draw by default.  However, if some other application opens, then 

start the LibreOffice Draw application, and find and open the EPS file directly with File > Open. 

 

Once the EPS file is open in LibreOffice Draw, select the fan chart with Ctrl-a, then copy it with Ctrl-c.   

 

Then in Microsoft Word, click your cursor where you wish the fan chart to go.  Paste it as “special”, 

either with the shortcut “Alt-e, s” (that is, hold down the Alt key, press “e”, then press “s”), or from the 

Word ribbon with “Home > Clipboard > Paste > Paste Special”.  Then choose the format “Picture 

(Enhanced Metafile)”.   

 

You now have the fan chart pasted in your document in the highest possible resolution.  If you have 

pasted it on a landscape page, you can drag the bottom right corner outwards to enlarge the image to 

create the largest possible image that will fit on that page.  And then if someone zooms into the fan 

chart, in the Word document or a PDF document, they will be able to more easily read the names 

printed in the smallest type in the outer edge of the fan chart. 

 

3.7  Printing This Document (PDF or Paper) 
 

(Remember to always right-click on the Table of Contents and the List of Images at the beginning of the 

document and select Update after any document changes, to make sure they are complete and the 

page numbering is correct, before printing). 

 

The best way to create a PDF is by selecting File > Save as, and then setting “Save as type” to PDF.  

This is the only way to obtain a PDF with all the intra-document links working, the links from the table 

of contents and between sections.  For PDF files to be browsed on a computer, this is the best method. 

 

You can also print this document to paper.  If you wish to get it bound, “coil” binding is better than 

“comb” binding, because it lasts longer and is easier to use, especially for larger documents.  You can 

also create a PDF for sending to a print shop with slightly higher image resolution by printing it as 

normal, but instead of selecting a physical printer, select a “PDF Printer” from the printer menu, for 

http://libreoffice.org/
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example “Microsoft Print To PDF” installed by default on most computers.  The images will have slightly 

higher resolution than saving the document as PDF, but the intra-document links won’t work. 

 

If you ever wish to, you can also print only some sections of the document.  This requires a few more 

steps, because the document has so many different portrait and landscape sections.  First, make sure 

the paragraph indicator is turned on, from Home > Paragraph > “¶”    

 

Next, right-click on the bottom border of the Word application.  From the “Customize Status Bar” 

window that pops up, make sure “Section” is checked, so the current section number is displayed in the 

“status bar” on the window border bottom left.  In the example below, the section is shown as “260”, 

because that is how many different sections are in the document at the time I am writing this. 

 

 
 

Then, figure out where you want your print to start and end. 

 

First, make sure you can see the section separator markings, by making sure the paragraph indicator is 

turned on from Home > Paragraph > “¶”    

 

Section separators will look like this: 

 

 
 

Place your cursor in the section where you want the print to start.  Wait a few seconds for the section 

number to update on the bottom left of the status bar.  Write down that section number.  

 

Then put your cursor in the section where you want the print to end.  Repeat the above to note that 

section number.   

 

Then open the print menu on Word, for example with <ctrl>-<p> or File > Print, and in the Pages field 

enter the first and last section you wish to print separated with a dash.  For example to print from 

section 42 to section 85 enter “s42-s85” without the quotes.  If you wish to print discontinuous 

sections, for example just section 21 and then from section 42 to 85, enter “s21,s42-s85” in the Pages 

field.  (If you don’t see the Pages field, look for the option Settings > Custom Print.) 

 

Then print to a PDF printer first to create a PDF file, make sure you have what you want, and then print 

the PDF to paper.  Always print to a PDF file first, making sure you got the sections you intended, and 

then print the PDF to paper.  Just remember the intra-document links will not work in that PDF – 

selective section printing is only good for paper printing. 

 

Enjoy! 
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